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Chapter 1

Introduction

Thanks for choosing Archaeopteryx Software’s Wing IDE Lite! This manual will help you
get started and serves as a reference for the entire feature set of this product.

The manual is organized by major functional area of Wing IDE, including the project
manager, source code editor, and debugger. Several appendices document the entire com-
mand set, provide pointers to resources and tips for Wing and Python users, and list the
full software license.

The rest of this chapter describes how to install and start using Wing IDE Lite. If you hate
reading manuals, you should be able to get started by reading this chapter only.

Throughout this manual, key concepts and important notes are highlighted in the same
way as this paragraph. If you are skimming only, look for these marks.

1.1 Product Levels

This manual is for the Wing IDE Lite product level of the Wing IDE product line, which
currently includes Wing IDE Standard and Wing IDE Lite.

Wing IDE Standard is the original Wing IDE product, and may be licensed for commercial
or non-commercial uses. Wing IDE Lite is for non-commercial use only and contains a
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2 Introduction

subset of the features found in Wing IDE Standard.

Wing IDE Standard and Wing IDE Lite are independent products and may be installed at
the same time on your system without interfering with each other.

For a list of features that have been omitted from Wing IDE Lite, please refer to
http://wingide.com/wingide/features

1.2 Licenses

Wing IDE requires either an evaluation or a paid license to run. When it is first started, it
will ask to copy your license file into place.

Evaluation licenses can be obtained from http://wingide.com/wingide/demo
These unlock all features of the product for a period of 30 days, but may be used for
evaluation purposes only.

Permanent licenses for non-evaluation use can be purchased in the online store at
http://wingide.com/order . These include free upgrades through the 1.x version
series.

Licensing is on a concurrent use basis, and requires a seperate license for each operating
system used. Licenses purchased for multiple users allow up to the purchased number of
users to run Wing at the same time on the licensed operating system.

1.3 Technical Support

If you have problems installing or using Wing IDE, please contact Archaeopteryx Tech-
nical Support at support@wingide.com , or visit the Technical Support website at
http://wingide.com/support

Bug reports may be sent to bugs@wingide.com . Please include your OS version number
and specific examples of the problem with each report.

See section 2.2.4 for more information on how to capture a log of Wing IDE and debug
process internals. Whenever possible, these should sent to Technical Support along with
your problem report.

Version 1.1.4 Wing IDE Lite Reference



1.4. INSTALLING 3

1.4 Installing

If you are upgrading Wing IDE and have previously applied patch files to your installa-
tion, you may need to remove Wing IDE completely before you upgrade. See section 1.9
for information on how to uninstall.

Quick start on Windows

Ensure that Python 1.5.2, 2.0, 2.1, or 2.2 is installed on your system. Obtain the
wingide-lite-1.1.4-1.exe installer package from wingide.com and execute it on
your system. After installing, run Wing IDE by selecting Wing IDE Lite 1.1  from the
Programs:Wing IDE Lite section of the Start menu.

Once Wing IDE Lite starts, follow the instructions to locate your license file Wing will be
copy it into place), accept the licensing agreement, and set up your initial preferences.

Quick start on Linux:

To install Wing for individual use on an RPM-based system, obtain wingide-
lite-1.1.4-1.i386.rpm and a license file from wingide.com , then run rpm -
I wingide-lite-1.1.4-1.i386.rpm as root.

For single-user installation on systems without RPM, obtain wingide-lite-1.1.4-
1.tar.gz and a license file from wingide.com , unpack the tar file with tar -

zxvf wingide-lite-1.1.4-1.tar.gz , cd to the wingide-lite-1.1.4-1 direc-
tory, type wing-install.py , and answer the questions to specify where the program
files should go.

After installing, the command winglite  should start the IDE. You may have to modify
your path if you've installed the executables in a directory that isn’t already on your
path. You may also have to open a new shell or request that your shell rescan the disk for
executables (for example, with rehash under tcsh).

Once Wing starts, follow the instructions to locate your license file (Wing will be copy it
into place), accept the licensing agreement, and set up your initial preferences.

Wing IDE Lite Reference Version 1.1.4



4 Introduction

1.4.1 Supported Platforms

This version of Wing is available for Microsoft Windows and Linux.

The Windows product has been tested on Windows 98se, NT4 SP3, Windows 2000 Pro-
fessional SP1, and Windows XP Professional.

The Linux product has been tested on RedHat 6.0, 6.1, 6.2, and 7.1; Suse 6.2, 6.4, and 7.0;
Caldera 2.4; Mandrake 6.1, 7.1, 7.2, and 8.0; and Debian 2.2.

On RedHat 6.0, you must install Python 1.5.2, 2.0, 2.1, or 2.2 and use that to run your
debug program and the tar file installer (if RPM is not used), instead of the default Python
1.5.1 installation that comes with RedHat 6.0.

On Suse, you may need to install the gmp and python packages, or install Python from
source, since Python is not installed by default here.

RedHat 5.2 is known not to work and there are no plans for supporting it.

1.4.2 Prerequisites

In order to use Wing, you need to have the following third party materials installed on
your system. Many of the above are available in the 3rdparty  directory on the product
CD and from ftp://wingide.com/pub/wingide

For Windows

e Python1.5.2,2.0,2.1, or2.2
e Internet Explorer, Netscape or other web browser (optional)

e Adobe Acrobat Reader 4.0.5 or later (optional)
For Linux

e Python1.5.2,2.0,2.1,0r 2.2
e enscript version 1.1.6 or later (for basic printing)

e Adobe Acrobat Reader version 4.0.5 or later (for better printing)

Version 1.1.4 Wing IDE Lite Reference



1.4. INSTALLING 5

e Netscape or other web browser (optional)

Most users already have these available. The RPM distribution will check for most of
these dependencies. If you are installing from tar, you must verify manually that you have
these installed, as there is no automatic dependency checker in the tar file installation.

By default, Wing uses Adobe Acrobat Reader and Netscape Navigator for viewing the
manual and other items in the Help menu. Other PDF viewers and web browsers can be
used instead; see section 2.2.5 for information on configuring these.

Gnome users should note that Wing comes with its own copy of GTK 1.2.8 that has dis-
abled use of themes. As a result, Wing ignores your theme settings and always runs
as if the Default theme were selected. This avoids problems with with some versions
of GTK and some themes. You can get Wing to run against your native installed ver-
sion of GTK, and to use themes, in one of two ways: (a) specify --system-gtk as the
first command line argument for the winglite  startup script, or (b) rename or move
WINGHOME/bin/gtk-bin  (be sure to retain a copy in case your system’s version of GTK
is one of those that causes frequent crashing in Wing).

1.4.3 Python versions

Wing contains its own subset of Python that is used to run the IDE itself (but not for your
debug programs). The debugger, which runs in a seperate process, can run under Python
15.2,2.0,2.1, or 2.2.

In most cases, Wing will work out of the box, will find your default python installation,
and will use it for debugging. You can, however alter the version of Python that is used
to debug your program by using Project Properties and per-file Debug Properties dialogs.
See section 5.2 for details.

The interpreter that is used for debugging is also used to determine which version of the
Python manual is displayed from the Help menu, and it affects which Python standard
libraries are used for source code analysis. See section 4.15 for more information.

1.4.4 Windows Installation

On Windows, Wing is installed by running the installer executable. Wing’s files
are installed by default in C:\Program Files\Wing IDE Lite , but this location

Wing IDE Lite Reference Version 1.1.4



6 Introduction

may be modified during installation. All users of Wing must have Create File
and Write privileges to C:\Program Files\Wing IDE Lite\profiles . This
is where per-user preferences and other information is stored on Windows. Ex-
cept for a shortcut in the Start menu heirarchy, all files are installed under
C:\Program Files\Wing IDE Lite (or your selected installation location).

In the text the follows, the installation location of Wing is referred to as WINGHOMEHEf you
installed to the default location, this is C:\\Program Files\Wing IDE Lite

1.4.5 Linux Installation with RPM

Wing can be installed from an RPM package on RPM-based systems, such as RedHat and

Mandrake. To install, run rpm -i wingide-lite-1.1.4-1.i386.rpm as root or use
your favorite RPM administration tool to install the RPM. Most files for Wing are placed
under the /usr/lib/wingide-lite directory and a link for the winglite ~ command

is placed in the /usr/bin  directory.

RPM installation also creates a directory called floating-locks in
lusr/lib/wingide-lite . This is set up to be world writable by default. If you
are worried about the security of this location, you may change its permissions or remove
it entirely, as long as you don’t plan a multi-user installation (described in section 1.8).

In the text that follows, the installation location of Wing is referred to as WINGHOMH(
you installed from RPM, this will always be /ust/lib/wingide-lite

1.4.6 Linux Installation from Tar Archive

Wing may also be installed from a tar archive. This can be used on systems that do not
use RPM, or if you wish to install Wing into a directory other than /usr/lib/wingide-
lite . Unpacking this archive with tar -zxvf wingide-lite-1.1.4-1.tar.gz

will create a wingide-lite-1.1.4-1 directory that contains the wing-install.py
script and a binary-package.tar file.
Running the wing-install.py script will configure Wing for use with individual

licenses (multi-user installation is described in section 1.8). The install script will
prompt for the location to install support files for Wing (WINGHOMEand the loca-
tion in which to create a symbolic link to winglite . These locations default to
lusr/local/lib/wingide-lite and /usr/local/bin , respectively. The install

Version 1.1.4 Wing IDE Lite Reference



1.5. RUNNING THE IDE 7

program must have read/write access to both of these directories, and all users running
Wing must have read access to both.

In the text the follows, the installation location of Wing is referred to as WINGHOMEf you
installed from tar, this will be the location you chose when you ran the installer.

1.4.7 Adding Wing to your Path (for Linux)

In many cases, the Wing executable will already be on the user path. If it is not, you may
type in the full path to Wing, or add the location where Wing’s executable was installed
to your path. This location will be /usr/bin if the IDE was installed from RPM. When
installed from tar file, it will be the value supplied to the wing-install.py script.

Setting the path may be done system-wide or individually. How this is done will differ
according to your exact OS version, the shell you are running and, in some cases, the
preferences of your system administrator. Typically, per-user setup is in “/.profile ,
"I.login , I.bashrc ,"/.cshrc , or equivalent shell configuration file, and system-
wide setup is accomplished with /etc/profile , letc/cshre , or /etc/csh.login

After installing or altering a user’s path, you may need to open a new shell for that user
or request that the shell rescan the disk for executables (for example, with rehash under
tcsh).

If for some reason you cannot set the path, typing the full path to the winglite  exe-
cutable, creating a small shell script containing the full path, or setting an alias will all
work as alternatives.

1.5 Running the IDE

You are now ready to use Wing IDE!
On Windows, start Wing IDE from the Program group of the Start menu.
On Linux, just type winglite

The first time you run, Wing will create your personal settings directory, “/.wingide
on Linux or WINGHOME\profiles\[username] on Windows. If no user is logged in
on Windows, ”"Default User” is used as the username. The personal settings directory
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8 Introduction

is used to store your license, preferences, and other files used by Wing. If the directory
cannot be created, Wing will exit.

Once the personal settings directory has been created, Wing will ask you to locate your
license file. This is the file that was emailed to you when you signed up to try the demo,
or purchased a permanent license. Once you locate the file, Wing will copy it into place
in “/.wingide/license.dat (on Linux) or WINGHOME\profiles\[username] on
Windows. You will then be asked to accept the license terms.

At this time, Wing will also take the opportunity to ask you to specify a few ma-
jor options, such as your preferred editor personality, print paper size (Linux only),
and whether or not to auto-save project files. You may either select values or ask
to always use the system defaults (as defined in WINGHOME/preferences ). Once
this is done, Wing will place a file called “/.wingide/preferences (on Linux) or
WINGHOME\profiles\[username] (on Windows), with contents according to your
choices. This will include at most only a few of all the available preferences, and you can
add to or alter these values at any later time. Please refer to WINGHOME/preferences
and the rest of this manual for more information about the supported options.

Whenever you run winglite  from the command line, you may specify a list of files to
open. These can be arbitrary text files and a project file. For example, the following will
open project file myproject.wpr  and also the three source files mysource.py , README
and Makefile

winglite mysource.py README Makefile myproject.wpr

(on Windows, the executable is called winglite.exe )

Wing determines file type by extension, so position of the project file name (if any) on the
command line is not important.

1.6 Installing a Permanent License

The Wing IDE evaluation license is a temporary single-user license that will expire one
month from date of issue, and may be used for evaluation purposes only. If you have
decided to purchase a permanent license from www.wingide.com , you will receive your
license file(s) via email.

If your evaluation license has not yet expired, you must remove or rename
your old license before installing your new license. The license file can
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1.7. INSTALLING EXTRA DOCUMENTATION 9

be found at WINGHOME\profiles\[username]\license.dat (on Windows) or
“/.wingide/license.dat (on Linux).

Next, run Wing and follow instructions when it prompts you to locate your license file.
The new file will be copied into place automatically.

1.7 Installing Extra Documentation

The Help menu in Wing IDE provides quick access to the online versions of the Wing IDE
manual, the Python documentation collection, and some useful web resources.

The HTML and PDF A4 and US Letter versions of the Wing manual are shipped by
default with Wing’s binary distribution. Additional manual formats are available from
http://wingide.com/support/library

If you are using Linux, the Python manual is not included in most installations, so
you may also wish to download and install local copies of these pages. Place the
top-level of the HTML formatted Python manual (where index.html  is found) into
WINGHOME/python-manual/##  in your Wing IDE installation. Substitute for #.# the
major and minor version of the corresponding Python interpreter (for example, 1.5 or
2.0 ). Once this is done, Wing will use the local disk copy rather than going to the web
when the Python Manual item is selected from the Help menu.

1.8 Multi-user Installations (Linux only)

A multi-user installation requires that you have the ability to share a common disk area
among all the machines that will participate in the installation. This is usually done via
NFS under Linux, although other file sharing techniques (such as Samba) will also work.

The primary difference between multi-user installation and single-user installation
is the location of the license file. In single-user installations, licenses are in
"“l.wingide/license.dat and license lock files are placed in /var/tmp . In multi-
user installations, licenses and license lock files are both in WINGHOME/floating-
locks .

There are two approaches to setting up a multi-user installation:
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e You can share the entire Wing installation directory to multiple machines. In this
case, the floating-locks directory must be writable by all users of Wing on all
of the machines, and WINGHOMHust either be on the users” path , symbolic links
from a location on the users’ path must be made to WINGHOME/winglite , or users
must set up aliases or type the full path to WINGHOME/winglite in order to start
Wing.

¢ You can install one Wing installation on each machine and replace the floating-locks
directory on each machine with a symbolic link to a directory accessible via NFS or
other file sharing mechanism. This must be done on each machine where Wing IDE
is installed, using commands similar to the following;:

cd /var/lib/wingide-lite
rmdir floating-locks
In -s <path-of-shared-directory> floating-locks

If you have installed from RPM, the floating-locks directory should already exist
and be world-writable on each installation, and the IDE should be configured to use it.
You only need to alter the installation if you want to change the permissions on the lock
file directory or if you want to replace it with a symbolic link, as described above.

If you installed from tar file, you need to perform the installation in a way that indi-
cates that you want it to work in multi-user mode. This is done by running wing-
install.py --multi-user . At the end of the installation process, this will ask for
the name of the directory that should contain license lock files and will create the direc-
tory if it does not exist. The script will also ask for the name of the group that all users of
the floating license must belong to. Use <everyone> to specify that all users can use the
floating license. Any group specified must exist prior to running the install script.

In either case, once installation is complete, you must copy the license file that you have
purchased into WINGHOME/floating-locks and make sure it is readable by all users
of the installation.
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1.9. REMOVING AN INSTALLATION 11

If copies of Wing crash or are terminated from outside, the license lock files located in
Ivar/tmp  (or in WINGHOME/floating-locks in multi-user installations) may be left
in place, consuming one user license each. Wing will normally remove stale lock files, but
can only do that for the host on which it is being started, thus in some cases leading to
exhaustion of the available licensed user count.

To fix this, remove those files for which no Wing instance is running. The file name com-
bines the license number, host name, and process ID of Wing so it is possible to determine
whether a file is a lost file or an active file:

BD12-A63A-690C-A517-pangolin-982

Be careful not to remove an active license lock file, as the Wing instance that is using it
will cease to function until it is restarted.

1.9 Removing an Installation

On Windows, use the Add/Remove Programs control panel, select Wing IDE Lite and
remove it.

To remove an RPM installation on Linux, type rpm -e wingide-lite

To remove a tar archive installation on Linux, invoke the wing-uninstall script in
WINGHOMHhis will automatically remove all files that appear not to have been changed
since installation, It will ask whether it should remove any files that appear to be changed.

If you previously applied patch files to your Wing installation, you may need to manually
remove remaining files and directories after uninstallation. In this case, you should retain
the folder profiles on Windows installations and floating-locks on Linux multi-
user installations if you plan to reinstall or upgrade Wing at a later date (these folders
contain license and preferences information).
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1.10 Command Line Argument

Wing treats any arguments given on the command line as file names that should be
opened into the IDE, except for the following valid options:

® -—prefs-file — Add the file name following this argument to the list of preferences files
that are opened by the IDE. These files are opened after the system-wide and default
user preferences files, so values in them override those given in other preferences files.

® -—new — By default Wing will reuse an existing running instance of Wing IDE to open
files specified on the command line. This option turns off this behavior and forces
creation of a new instance of Wing IDE. Note that a new instance is always created if
no files are given on the command line.

e -—verbose — (Posix only) This option causes Wing to print verbose error reporting out-
put to stderr.

e —display — (Posix only) Sets the X Windows display for Wing to run with. The display
specification should follow this argument, in standard format, e.g. myhost:0.0

e -—use-winghome — (For developers only) This option sets WINGHOME to be used dur-
ing this run. It is used internally and by developers contributing to Wing IDE. The
directory to use follows this argument.

e —use-src — (For developers only) This option is used to force Wing to run from Python
source files even if compiled files are present in the bin directory, as is the case after a
distribution has been built.

® —orig-python-path — (For developers only) This option is used internally to indicate the
original Python path in use by the user before Wing was launched. The path follows
this argument.

e —squelch-output — (For developers only) This option prevents any output of any kind
to stdout and stderr. Used on Windows to avoid console creation.
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Chapter 2

Customization

This chapter describes how you can customize Wing IDE according to your needs.

Wing may be customized in the following ways:
® Through the preferences files
e Keyboard shortcuts can be defined for any Wing command

® The editor can run with different personalities, including a generic editor personality
and an emacs-like mode

® The menubar and toolbar can be altered

2.1 Preferences

Wing has a set of preferences that control the basic layout of the user interface and affect
features of the editor, debugger, source browser, and project manager. Although Wing
will prompt you to select a few options the first time you run the IDE, it is likely that you
will want to refine your preferences settings subsequently.

Default values for all preferences are set in the file WINGHOME/preferences . Individ-
ual users can override these by placing a preferences file in the .wingide  subdirectory of
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their home directory (on Linux) or WINGHOME\profiles\[username] (on Windows),
which are created the first time Wing is run. The values given in the user-specific prefer-
ences file take precedence over any values in the default WINGHOME/preferences file.

It is also possible to specify additional preferences files on the command line though the
--prefs-file option. For example:

winglite --prefs-file /path/to/myprefs

The individual preferences are documented in this chapter and the chapters that follow
for each IDE subsystem.

Note that setting a preference currently requires quitting and restarting Wing before the
preference takes effect.

2.1.1 Preferences File Format

The preferences file format consists of a sequence of lines, each of which is a name=value
pair.

The name is in domain.preference form, where domain is the IDE subsystem affected and
preference is the name of the specific preference (for example, edit.personality de-
fines the source editor’s runtime personality).

Preference values can be any Python expression that will evaluate to a number, string,
tuple, list, or dictionary. Additionally, the constants true and false are defined and
bound to 1 and 0, respectively. Long lines may be continued by placing a backslash (\\ )
at the end of a line and comments may be placed anywhere on a line by starting them
with #.

For security’s sake values in a preferences file are evaluated in the context of a restricted
execution space and cannot access the disk or network. See the Python Language Man-
ual’s RExec module for more information on these restrictions.
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2.2 Configuring the User Interface

We ship Wing configured in a way we think will be most usable for the widest range of
users. However, a range of options exist to users who want to alter the user interface to
suit their needs.

2.2.1 GUI Modes

The graphical user interface can run in several modes, controlling how the menu bar
and toolbar are presented, and how many windows are used to display source files and
managers like the debugger and source code browser.

These modes are set using the following preference:

[0 gui.one-view-per-window - Set to true to open a new window for each source code
document that is opened. Otherwise, windows are reused unless explicitely created.
In this case a window may contain several documents, of which only one is visible at
any given time. Default=false

00 gui.embed-command-bar - Set to true to embed the command bar within each
source or manager window. Otherwise, a floating window containing a single shared
menu bar and toolbar is shown at the top of the allocated screen area. Default=true

You can also change the screen area that will be used by Wing and how windows will be
presented initially:

0 gui.work-area-rect - Specifies the screen rectangle within with Wing will display
all its windows. The rectangle is in (left, top, right, bottom) format, for exam-
ple (10, 10, 1250, 930) . When set to None, the full screen size is used.
Default=None

00 gui.initial-window-size - Defines initial window size for document windows in
(width, height) format, for example (650, 1000) . When set to None, a best guess
based on screen size is made. Default = None

0 gui.initial-window-position - Defines (x, y) pixel offset of the first window within the
work rectangle. Default=(10, 10)

Wing IDE Lite Reference Version 1.1.4



16

Customization

gui.stagger-window-position - Set to true to stagger windows rather than bringing
up all new windows at the same location. Default=true

gui.remember-window-positions - Set to true to remember window positions so
that documents and other windows are opened at using their last position and size.
Default=true

gui.show-toolbar - Set to true  to include the toolbar in windows displayed by Wing
or false to always hide the toolbar. Default=true

gui.show-toolbar-in-browser - Set to true to include the toolbar in the source
browser window or false to exclude it from this window. Default=false

gui.enable-tooltips - Set to true to display tooltips when the mouse cursor is above
an enabled toolbar icon, or false never to show tooltips. Caution: On Linux, tooltips
have bugs that cause the GUI to hang up under gtk versions less than 1.2.8. Do not enable this
if you've set Wing up to run with an older version of gtk. Default=true .

It is also possible to control which manager windows are visible at IDE startup, and
whether or not the most recently open project file is reopened automatically:

g

main.startup-show-project - Set to true to show the project manager window at
startup. Default=true

main.startup-show-browser - Set to true to show the source code browser window
at startup. Default=true

main.startup-show-debugger - Set to true  to show the debugger window at startup.
Default=false

main.auto-reopen-last-project - Set to true to reopen the most recently open project
file at startup, if no other project file is given on the command line. Default=true

2.2.2 Editor Personalities

Wing ships with a default editor personality that acts like a simple graphical text editor.
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The first thing any emacs user will want to do is to set the editor personality to emulate
emacs! This is done with the editor’s personality preference:

[0 edit.personality - Setto’'normal’  for vanilla key bindings and actions, and 'emacs’
for emacs-like operation. Default="normal’

Additional information about the editor personalities can be found in sections 4.11 and
4.12 of the Source Code Editor chapter.

2.2.3 Key Equivalents

Wing ships with two key equivalency maps, both found in WINGHOMKeymap.normal
and keymap.emacs . These are used as default key maps for the corresponding editor
personalities.

However, it is possible to copy these maps and customize them. If you do this, it is best to
start with the mapping that most closely matches the editor personality you plan to use.

Key binding definitions in these files are in the form:
'key-sequence’: 'ide-command’

The command portion of the key equivalency definition may be any of the commands
listed in this manuals in appendix A. The key sequence is built from key names defined in
WINGHOME/pygtk-0.6.5/GDK.py  starting at line 300; the names are matched without
regard to case. A single unmodified key is specified by its name alone (for example,
'Down’ for the down arrow key). Modified keys are specified by hyphenating the key
names (for example, 'shift-Down’ for the down arrow key pushed while shift is held
down). Multiple modifiers may also be specified, as in ’ctrl-shift-Down’

It is also possible to build multi-key combinations by listing multiple key names separated
by a space. For example, to define a key equivalent that consists of first pushing ctrl-x and
then pushing the a key by itself, use 'ctrl-x &’ as the key sequence.

Wing may be set to use the customized key map file through the following preference:
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00 gui.keymap - The full path to the alternate keymap to use, if any. Default="

Note that key bindings defined in your mapping will be shown in any menu items that
implement the same command. This makes it easier to learn key bindings while using
Wing.

2.24 Debug Trace Logs for Wing IDE

It is possible to run Wing IDE in such a way that prints debug output for Wing IDE
and the debug machinery itself. If you are having problems with Wing or cannot get
debugging working, this may reveal some information that will help in working with
Technical Support.

Logging Wing IDE Internals

On Windows, do this by executing console_winglite.exe instead of
winglite.exe . In this case, Wing will open a new console window where debug
output will be displayed.

On Linux, pass --verbose as the first command line argument to winglite . Here,
debug output will be printed to the shell window from which you launched Wing.

Whether or not you enable debug output, Wing always logs debug information to a pe-
riodically truncated file called error-log , which is placed in your Wing configuration
directory. On Linux, this is "/.wingide . On Windows, it is profiless’USERNAME
below your Wing IDE installation directory. USERNAMEs replaced with the user name
under which you are logged in.

Logging Debugger Internals

Similar debug output for diagnosing problems in the debugger internals is controlled
seperately by setting the debug.verbose  preference to true , and/or by setting
debug.logfile preference to a non-None value (however, the specified file must ex-
ist or logging will be disabled).

When using wingdbstub  logging of debugger internals is controlled by setting kSilent
to 0 or by setting WINGDB_SILENT environment variable. Similarly, kLogFile  or
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WINGDB_LOGFILEenvironment variable can be used to direct internal logging to a disk
tile. Again, the disk file must already exist or logging is disabled.

Combined Logging

Although Wing IDE and the debug program run in seperate processes, it is acceptible to
direct the debug process” internal logging into Wing’s error-log  file. This produces a
single chronological combined log, which can be sent to Archaeopteryx Technical Sup-
port.

2.2.5 Other Preferences

Some additional preferences are also available for controlling top-level behaviors:

0 gui.display-font-name - Map of font names to use by default on each supported plat-
form. This affects all areas of the user interface other than the source code editor. A
value of None causes Wing to use the externally configured default for that platform.
Default={ ’linux’: None, 'win32: None }

O gui.display-font-size - Map of font sizes (in int form) to use by default on each sup-
ported platform. This affects all areas of the user interface other than the source code
editor. A value of None causes Wing to use the externally configured default for that
platform. Default={ ’linux’: None, 'win32’: None }

[0 gui.open-projects-as-text - When set to true , Wing will open project files as text when
they are opened from the File menu. Otherwise, any file with .wpr or .wpu extension
is opened as a project file regardless from where it is opened. Default=false

0 gui.max-recent-files - Maximum number of files to show in the recent files lists in the
File and Project menus. Default10

0 gui.source-title-style - Title format used for source files: One of “prepend-relative”,
which prepends the partial relative path from the project file location to the source
file, "append-relative”, appends the partial relative path after the source file name,
“prepend-fullpath” to always prepend the full path, “append-fullpath” to always ap-
pend the full path, or “name-only” to always use only the file name without showing
any path information. Default="append-relative"
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gui.file-display-cmds - Linux only: The commands used to display local disk files
from the Help menu, or project files selected for external display. This is a map
from mime type to a list of display commands; each display command is tried in
order of the list until one works. The mime type "*" can be used to set a generic
viewer, such as a web browser. Use %s to place the file name on the command
lines. On Windows, the system-wide configured default viewer for the file type
is used instead so this preference is ignored. Default= { 'application/pdf’:

[ 'acroread %s &', 'ghostview %s &' ], ™: [ "netscape -remote
‘'openFile(%s)™, "netscape %s &" |, }

gui.url-display-cmds - Linux only: The commands used to display URLs. This
is a map from protocol type to a list of display commands; each display com-
mand is tried in order of the list until one works. The protocol "™*" can be
used to set a generic viewer, such as a multi-protocol web browser. Use %s to
place the URL on the command lines. On Windows, the system-wide config-
ured default web browser is used instead so this preference is ignored. Default=
{ ’http’: [ "netscape -remote 'openURL(%s)™, "netscape %s &" ],

* [ "netscape -remote 'openURL(%s)™, "netscape %s &" ], }

gui.auto-save-before-action - Set this to control whether or not altered source files are
auto-saved before taking actions like starting a debug run, executing a file, or running
a build command. When set to false the user is instead prompted for action. The
user will be prompted for file names for untitled files in all cases, even when this
preference is set to true . Default=false

gui.ignore-unsaved-before-action - Set this to control whether or not altered source
tiles are ignored before taking actions like starting a debug run, executing a file, or
running a build command. When set to false the user is prompted for action if
gui.auto-save-before-action is false or there are untitled files. When set to
true , unsaved files are left unsaved and the action simply starts. Warning: Setting
this preference to true may result in debugging or executing source code that does
not match what is displayed in Wing’s source editor windows. Default=false

gui.set-win32-foreground-lock-timeout - Used on Windows only: Controls whether
or not to set the foreground lock timeout on Windows 98/ME and 2K/XP. On these
systems, normally Wing will be unable to bring source windows to front whenever
the debug process has windows in the foreground. When this preference is true, the
system-wide value that prevents background applications from raising windows is
cleared whenever Wing is running. This means that other apps will also be able to
raise windows without these restrictions while Wing is running. Set the preference
to false to avoid this, but be prepared for windows to fail to raise in some instances.
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Note: If Wing is terminated abnormally or from the task manager, the changed value
will persist until the user logs out (or reboot on 98/ME). Default=true

O gui.list-typing-timeout - Sets the timeout in seconds to use for typing on list views,
after which keys pressed are considered a seperate typing-to-select event. Before
the timeout subsequent keys are added to previous ones to refine the selection.
Default=3.0

00 main.extra-mime-types - This is a map from file extension to mime type. It can
be used to add additional mime types to those built into Wing IDE and those
found in standard system-wide configuration files. Keys should be the file exten-
sion in lower case, and values should be the mime type in lower case, for example
{ ’gif': ’image/gif’ } . Any value defined here will override the Wing-defined
defaults and any system-wide defaults. Default={}

O main.extra-mime-type-names - This is a map from mime type to human readable
names for mime types. One entry should be added for each new mime type added
with extra-mime-types (but this is not needed if just adding a new extension to an
already-supported mime type). An example entry is { 'image/mpmp’: 'Multi-
pixel moon phase image’ } . Names given here can also be used to override the
Wing-defined default names for files. Default={}

00 main.use-native-file-selector - Set this to true to use the file selector that’s native to
your platform (for example, the Windows file selector instead of the GTK selector).
Default=true

0 main.max-error-log-size - Set the size in bytes at which the error log file is truncated.
This file is found in WINGHOME\profiles\[lusername]\error-log on Windows
and “/.wingide/error-log on Linux. Default=100000
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Chapter 3

Project Manager

This chapter describes how to use the Wing IDE project manager.

The project manager is designed to act as a convenient index into the files of your software
project, without tying you to Wing or requiring other developers that you work with to
use Wing.

It is possible to run Wing without using the project manager. However, doing so will
prevent the source browser and other source analysis-based capabilities (such as source
index menu and auto-completion) from easily discovering the extent of your source code
base. For this reason, we recommend setting up a project file for your work.

3.1 Creating a Project

Before creating a project, make sure that your project manager window is visible. If it
isn’t, choose the Project Manager item in the Windows menu to display it.
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3.1.1 New Project

To create a new project, use the New Project item in the Project menu. This will prompt
you to save any changes to your currently open project and will create a new blank
project. If Wing is started without any command line arguments, a blank new project
is opened by default.

3.1.2 Adding Files and Packages

To add files to your project, use the Add File, Add Package, and Add Directory Tree menu
items in the Project menu. These can also be accessed from the popup menu that appears
when right-clicking your mouse on the surface of the project manager window.

® Add Current File will add the frontmost current open file to the project if it is not
already there.

® Add File will prompt you to select a single file to add to the project view. Note that
this also may result in adding a new directory to the project manager window, if that
file is the first to be added for a directory.

® Add Package can be used to add more than one file at once. Select a directory with
your left mouse button so that the directory name is shown in the area at the bottom
of the file selection window. Then click OK. You will be prompted with a list of files
within the selected directory. Highlight any that you wish to add, using shift-click to
highlight a contiguous range or ctrl-click to select an arbitrary set. Then click Yes to
add all those files to your project.

® Add Directory Tree can be used to add many files in a directory structure in one op-
eration. Select a directory with your left mouse button so that the directory name is
shown in the area at the bottom of the file selection window. Then click OK to add files
recursively from that directory and all its children.

Note that Add Package and Add Directory Tree operate only on files that Wing considers
likely to be relevant for adding to the project. If the list is missing files you wish to add,
you will need to change the package-file-types package-omit-types preferences
and restart the IDE. See the section 3.7 below for details.
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3.1.3 Setting a Main Debug File

Normally, Wing will start debugging in whatever file you have as your front- most win-
dow. Depending on the nature of your project, you may wish to specify a file as the
default debug entry point.

To do this, right-click on one of your Python files in the project manager window and
choose the Set As Main Debug File option from the popup menu, or use the Set Current
as Main Debug File item in the Project menu. This file is subsequently run whenever
you start the debugger, except if you use the Debug Selected File popup menu item on a
specific file or the Debug Current File item in the Run menu.

Note that the path to the main debug file is highlighted in red in the project window. You
may clear the default debug entry point with the popup menu’s Clear Main Debug File
item or the Clear Main Debug file in the Project menu.

3.1.4 Removing Files and Packages

To remove a specific file, select it and use the Remove From Project menu item in the right-
click popup menu from the surface of the Project Manager window, or from the Remove
Selected Entry item in the Project menu. You can also remove a whole package directory
and all the files that it contains in this way.

3.1.5 Saving the Project

You can save your project at any time with the Save Project item in the Project Menu. You
will also be prompted to save if you try to close the project, open another project, or exit
Wing and you have an unsaved, altered project.

It is possible to set up automatic saving of project files, which is often convenient as they
are altered by many actions taken from the user interface. To do this, set the proj.save-
without-asking preference to true .

You can also save a copy of your project to another location or name with Save Project As
in the Project menu.
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Using Save Project As is recommended if you need to alter the location of your project
file in relation to your source files because it will update the partial relative paths that the
project manager uses to locate files in the project. Otherwise, Wing may not be able to
find all of the files in the project.

3.2 Keyboard Navigation

Once it has the focus, the project manager tree view is navigable with the keyboard, using
the up/down arrow keys, page up and page down, home/end, and by using the right ar-
row key on a parent to expand it, or the left arrow key to collapse a parent. Holding down
the shift key while pressing the right arrow will expand recursively below the expansion
point. Recursive expansion is capped at five additional levels for each operation to avoid
difficult-to-detect infinite recursions. Whenever a tree row is selected, pressing enter or
return will open that item within Wing IDE.

3.2.1 Shared Project Data

This section enumerates the values stored in the shared project area:

e file list - A list of all the files in the project, using partial relative path names based on
the location of the project file.

® main_debug file - The file that you have selected as the main entry point for execution.

e version - The version of Wing that wrote this file.

® build_cmd - A build command that is executed before debugging any file in the project.

e file type - Either 'shared” or 'normal’, indicating the project type as described above.

® shared file_attributes - Values associated with specific files in the project that are rel-
evant to all developers. This currently includes per-file debug options, such as the
PYTHONPATH to use, the Python executable to run under, arguments to pass on the
command line, the initial run directory, and a build command to execute before de-
bugging that file. Also included here are per-file positioning or view configuration
options.
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3.2.2 User-specific Project Data

This section enumerates the values stored in the user-specific project area:

® version - The version of Wing that wrote this file.

® user file_attributes - Values associated with specific files in the project that are specific
to an individual developer. This includes breakpoints, various debugger run options,
and window position information.

3.3 Project-wide Properties

Each project has a set of top-level properties that can be accessed and edited via the Prop-
erties item in the Project menu. Because these are all debugger-related properties, they
are described in the Debugger chapter in section 5.2.1. Note however that these values
also inform the source code analysis engine, as described in section 4.15.

3.4 Per-file Properties

Properties similar to those available for the project as a whole can also be set on a per-file
basis. This is done by right-clicking on a Python source file and selecting the Set Debug
Properties menu item in the popup. Values entered here will override any project-wide
values.

Since these all control the debugger, per-file properties are documented in the Debugger
chapter in section 5.2.2. See also section 4.15 for information on how these values affect
the source code analysis engine.

3.5 Viewing File Information

The bottom of the project manager window contains a file information area that will dis-
play file name, file type, and file-level documentation string (when available) for the cur-
rent selection in the file selection area of the project manager window.
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The documentation string contains the file-level docstring for Python files only and cur-
rently does not support any other programming languages.

The size of this area can be altered by dragging the divider handle between the file infor-
mation area and the rest of the project manager window.

3.6 Navigating to Source

Files can be opened from the project manager window by double clicking on the file name,
middle-clicking on the file name, or right-clicking and using the Open in Wing IDE menu
item.

Files may also be opened using an external viewer or editor by right-clicking on the file
and using the Open in External Viewer item. On Windows, this opens the file as if you
had double clicked on it in Windows Explorer. On Linux, the preferences gui.file-
display-cmds  and main.extra-mime-types can be used to configure how files are
opened. See section 2.2.5 for details.

It is possible to debug specific files (even if you have set a main debug file for your project)
by right-clicking on the file in the project manager window and choosing the Debug Se-
lected File item from the popup menu. A debug session for the selected file is launched,
but the definition of the main debug file is not altered.

You can also execute Makefiles, python source, and any executable files by selecting the
Execute Selected File item from the popup menu. This executes outside of the debugger
with any input/output occurring in the window from which Wing was launched.

3.7 Preferences

The following preferences affect the project manager:

O proj.package-file-types - The file types that will be included when you select the Add
Package or Add Directory Tree menu items from the Project menu and choose a direc-
tory for loading into the project. Default= ("*.*",)

O proj.package-omit-types - The file types that will be omitted when you se-
lect the Add Package or Add Directory Tree menu items, even if a wild-
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card found in proj.package-file-types matches the given file. Default=
("*.O", "*a", "*.so", "*.pyC", "*.pyO", “core", "™, "#*#")

O proj.file-panel-percent - The percentage of the total project manager window height
that will be used initially by the file area. Set this to 100 if you don’t want to see the
file information area. Default=60

O proj.file-type - The default file type for newly created project files, either 'normal’
or 'shared’” . Default="normal’

O proj.save-without-asking - Controls whether the project files will be saved without
asking the user. Default=true

O proj.reopen-windows - Selects whether the list of open windows should be saved and
reopened later when a project is opened. Use false to open only the project when a
project is opened and true  to open the project and also any windows that were open
the last time the project was closed. This includes both source windows and manager
windows. Default=true

00 proj.close-also-windows - When true , all document windows open at time of project
close will also be closed. When false only the project will be closed and other win-
dows will remain untouched. Default=true

Changing these values requires you to restart Wing before they take effect.
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Chapter 4

Source Code Editor

Wing IDE’s source code editor is designed to make it easier to adopt the IDE even if you
are used to using other editors. If you are frustrated by the editor or key combinations,
please review information in this chapter and in the Customization chapter; you have a
fair amount of control over how the editor acts.

For those in a rush, key things to know about the editor are:

® The editor has personalities, including one similar to basic editors on Windows and
another similar to emacs.

e Key mappings are configurable.
® The editor supports a wide variety of file types for syntax colorization.

® Auto-completion is supported for Python source (but can be turned off if desired).

4.1 Using multi-view window mode

When preference gui.one-view-per-window issetto false (the default value), Wing
will place newly opened or created editor views into the most recently used editor win-
dow.
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While working in this mode, you can use the Windows menu to switch to hidden views,
or to views shown in other windows. Note that the Windows menu is organized by
window type, starting with manager windows like the debugger and project manager,
then dialog windows if any are open, then visible source views, and finally a list of all
other views that are not currently visible on the display. When you switch to a non-
visible view, it is brought to front within its window and then its window is brought to
front in the display.

Whenever a newly opened file is already open in some window, Wing will show the
existing view into the file by bringing its window to front, instead of opening another
view into the file. Also, in multi-view mode, closing a view will not close its window
unless it is the last view in that window.

4.2 Using single-view mode

When multi-view mode is turned off, Wing will open one window for each source docu-
ment. The Windows menu will still list all open views but will not distinguish between
visible and hidden views, since all views will be visible in a window.

4.3 Syntax Colorization

The editor will attempt to colorize documents according to their MIME type, which is
determined by the file extension, or content. For example, any file ending in ".py’  will
be colorized as a Python source code document. Any file whose MIME type cannot be
determined will display all text in black normal font by default.

If you have a file that is not being recognized, you can use the Source Menu’s Syntax
Highlighting section to alter the way the file is being displayed. Your selections from this
menu are stored in your project file, so changes made here are permanent in the context
of that project.

If you have many files with an unrecognized extension, you can alter the main.extra-
mime-types preference to add your extension. See section 2.2.5 for details on setting this
value. Note however that adding a new MIME type not already in the list above will not
work without more extensive modifications to the IDE source code.
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4.3.1 Supported file types

The editor supports the following file types for syntax colorization:

Mime Type Description Allowable Extensions

text/x-python Python Source py, cgi, or files starting with a #! specifier
that invokes Python

text/html HTML Source html, htm, asp, shtml

text/x-c-source C Language Source ¢, h

text/x-cpp-source | C++ Source cc, cpp, cxx, hh, hpp, hxx

text/x-java-source | Java Source java

text/x-vb-source | Visual Basic Source cls, bas, ctl, frm, vbs

text/x-dos-batch | DOS Batch File bat

text/x-properties | DOS Style INI File properties, ini, inf, reg

text/x-makefile Makefile makefile, mak, and any file named
‘'makefile” or "Makefile’

text/x-errorlist Compilation Error List err

text/x-sql SQL Source sql

text/x-plsql PL SQL Source spec, body, sps, spb, sf, sp

text/x-xml XML Source xml, xul, glade

application/x-tex | LaTeX Source tex, sty

text/x-lua-source | Lua Source lua

text/x-idl CORBA IDL idl, odl

text/x-javascript | Javascript js

text/x-rc DOS RC File rc, rc2, dlg

text/x-php-source | PHP Source php, php3, phtml, inc

text/x-perl Perl Source plL, pm, pod

text/x-diff Diff/CDiff or Patch File diff, patch

text/x-conf Conf Files conf

text/x-pascal Pascal Source pas, inc

text/x-ave Ave document ave

text/x-ada Ada Source abs, adb

text/x-ave Eiffel Source e

text/x-ave Lisp Source Isp, lisp

text/x-ave Ruby Source b

text/x-ave Bash File sh, bsh

text/plain Plain Text (no highlighting) | all others
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4.3.2 Colorization Options

Although the specific colors and other values associated with syntax colorization are not
yet user-configurable, you can alter the text and font that is used throughout a file or files.
To do this, select the Set Display Font/Size item from the Source menu and make your
selection from the dialog’s popup menus.

You can make changes for individual files on a per-file basis, or for all files that you open.
Either way, your selection is saved in the project file for subsequent work sessions.

Changes are shown immediately on your source, but are only permanent after the
font/size selection dialog is closed if you use the Apply and Exit button. Otherwise,
values are restored to those in use before the selector dialog was displayed.

4.4 Navigating your Source

When you right-click on the surface of the editor, all editor windows will bring up a
popup menu with commonly used commands such as Copy, Paste, Undo, and Redo.
When the file is a Python file, this menu also includes a construct-by-construct break-
down of the source file.

In order to navigate your source, right-click on the editor surface and select one of the
constructs in the popup menu. This will scroll the source code to the position at which
that construct is defined and select its point of definition.

Python language constructs in the popup menu are colorized as follows:

® C(lasses are shown in red
® Variables, object attributes, and imported names are shown in green

® Methods and functions are shown in black

You can also use the Goto Definition menu item in the right-click popup menu to click on
a construct in your source and zoom to its point of definition.
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The editor popup menu is also available from the popup button at the lower right corner
of the editor window.

4.5 Brace Matching

Wing will highlight matching braces in green when the cursor is adjacent to a brace. Mis-
matched braces are highlighted in red.

You can also cause Wing to select the entire contents of the innermost brace pair from the
current cursor position with the Match Braces item in the Source menu.

Parenthesis, square brackets, and curly braces are matched in all files. Angle brackets (<
and >) are matched also in HTML and XML files.

4.6 Indentation

The editor provides a range of features for managing indentation in source code. The
following preferences affect how the indentation features behave in newly created source
files:

1. The preference edit.tab-size defines the default size of each tab character, in
spaces.

2. The preference edit.indent-size defines the default size of each level of indent,
in spaces.

3. The preference edit.indent-style defines the default indentation style, one of
'spaces-only’ , 'tabs-only’ , or 'mixed’ . Mixed indentation replaces each

tab-size spaces with one tab character.

4. The preference edit.auto-indent controls whether or not each new line is auto-
matically indented.

5. The preference edit.show-indent-guides controls whether or not to show in-
dentation guides as light vertical lines. This value can be overridden on a file by file
basis from the Indentation section of the Source menu.
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When an existing file is opened, it is scanned to determine what type of indentation that
is used in that file. If the file contains some indentation, this may override the tab size,
indent size, and indent style values given in preferences and the file is subsequently in-
dented in a way that matches its existing content rather than with your configured de-
faults. If mixed forms of indentation are found, the most common form is used.

For Python files, the detected form of indentation cannot be overridden and Wing will al-
ways match new indentation to existing indentation. Mixing indentation styles in Python
is dangerous because indentation has syntactic importance in this language.

For non-Python files, you can change indentation style on the fly using the Use Spaces
Only, Use Tabs Only, and Use Mixed Tabs and Spaces items in the Indentation portion of
the Source menu. This allows creating files that intentionally mix indentation forms in
different parts of the file. To ask Wing to return to the form of indentation it determines
as most prominent in the file, select the Use Style Matching File item in the Indentation
section of the Source menu.

Tab size is automatically forced to 8 characters for all Python source files that contain
some spaces in indentation. This is done because the Python interpreter defines tabs as 8
characters in size in this case. This version of Wing does not recognize vi style tab size
comments, but it does apply the edit.tab-size preference when a file contains only
tabs in indentation, or if it is a non-Python file.

4.6.1 Auto-Indent

The IDE ships with auto-indent turned on. This causes leading white space to be added to
each newly created line, asreturn  or enter are pressed. Enough white space is inserted
to match the indentation level of the previous line, possibly adding a level of indentation
if this is indicated by context in the source (such as if or while ).

Note that if preference edit.auto-indent is set to false , auto-indent does not occur
until the tab key is pressed.
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4.6.2 The Tab Key

By default, the tab key acts like auto-indent: the leading white space of the current line is
adjusted to achieve a reasonable indentation level for that line.

Existing leading white space is replaced with white space containing either spaces only
or tabs and spaces, as determined by the method described above. This behavior may
also decrease indent level of a line, if it is deemed to be indented too far according to its
context.

If multiple lines are selected at the time that the tab key is pushed, all those lines will be
indented or outdented as a unit according to the amount of change necessary for the first
line in the selected unit. This is very useful when moving around blocks of code.

To insert a real tab character regardless of the indentation mode or the position of the
cursor on a line, type ctrl-tab.

4.6.3 Checking Indentation

Wing also indicates suspiciously mismatch indentation on the source code by underlining
the indent area of the relevant lines in blue.

In general, mixing tab/space and space-only indentation in the same file can be confus-
ing, especially if files are viewed with different editors and by different developers. We
recommend using spaces only or tabs only as the best alternatives. To convert existing
code containing a mix of tabs and spaces, use the Indentation Manager.

4.6.4 Changing Block Indentation

Wing provides Indent and Outdent commands in the Indentation portion of the Source
menu, to support increasing or decreasing the level of indentation for selected blocks of
text. All lines that are included in the current text selection are moved, even if the entire
line isn’t selected.

Indentation placed by these commands will contain either only spaces, only tabs, or a
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mixture of tabs and spaces, as determined by the method described at the start of section
4.6 above.

4.7 Auto-completion

While typing in Python source code, Wing will display an autocompletion popup that can
be used to reduce your typing burden. To use it, type until the correct symbol is hilighted
in the list and then press the tab key. Wing will fill in the remaining characters for the
source symbol, correcting any spelling errors you might have made in the name.

If you wish to select a name without typing enough of the name to make your selec-
tion unique in the autocompleter, you can use the keyboard up and down arrow keys or
mouse to scroll up and down in the popup list. Pressing tab or double clicking on a list
item will complete that symbol in your source.

To cancel out of the autocompletion popup, press the Esc key or ctrl-g . The auto-
completer will also disappear when you exit the source symbol (for example, by pushing
space or any other character that can’t be contained in a source symbol), if you click
elsewhere on the surface of the source code, or if you issue other keyboard bound com-
mands that are not accepted by the autocompleter (for example, save through keyboard
equivalent or right/left arrow keys).

Auto-completion covers most but not all possible scenarios at this time. See section 4.15
for more information on current capabilities.

Until Python includes support for data typing, one way to get a lot more mileage out
of the auto-completion facility is to use statements that assert variables as belonging
to a specific class. An example is assert isinstance(obj, CMyClass) . The code
analysis facility will pick up on these and present you with the correct auto-completion
values when you type obj. subsequently. An added bonus is that your code will catch
errors in expected variable types in more cases.
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4.8 Auto-save

The source code editor auto-saves files to disk every few seconds. The autosave failes are
placed in a subdirectory of your Wing user directory (*/.wingide/autosave on Linux
or WINGHOME \profiles\[username]\autosave on Windows). If Wing ever crashes
or is killed from the outside, you can use these files to recover any unsaved changes. It is
usually safe to copy the autosave files to overwrite the older unsaved files, but you may
want to do a comparison first to verify that the autosave file is what you want.

4.9 Notes on Copy/Paste
There are a number of ways to copy and paste text in the editor:

® Use the Edit menu items. This stores the copy/cut text in the system-wide clipboard
and can be pasted into or copied from other applications.

e Use key equivalents as defined in the Edit menu.
® Right-click on the editor surface and use the items in the popup menu that appears.

® On Linux, select text anywhere on the display and then click with the middle mouse
button to insert it at the point of click.

® On Windows, click with the middle mouse button to insert the current emacs kill buffer
(if in emacs mode and the buffer is non-empty) or the contents of the system-wide
clipboard (in all other cases).

® In emacs mode (described in section 4.12 below), ctrl-k (kill-line) will cut one line at
a time into the kill buffer. This is kept seperate from the system-wide clipboard and
is pasted using ctrl-y (yank-line). On Windows, ctrl-y will paste the contents of the
system-wide clipboard only if the kill buffer is empty.

® Select a range of text and drag it using the drag and drop feature.

It's important to note which actions use the system-wide clipboard, which use the emacs
kill buffer (emacs mode only), and which use the X windows selection (X Windows only).
Otherwise, these commands are interchangeable in their effects.
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4.10 Auto-reload of Externally Changed Files

Wing’s editor detects when files have been changed outside of the IDE and can reload
files automatically, or after prompting you for permission. This is useful when working
with an external editor, or when using code generation tools that rewrite files.

Wing’s default behavior is to automatically reload externally changed files that you have
not yet been changed within Wing’s source editor, and to prompt to reload files that have
also been changed in the IDE.

You can change these behaviors by setting the value of the cache.unchanged-reload-
policy and changed-reload-policy preferences, as described at the end of section
4.16.

On Windows, Wing uses the change signal capability of the OS to detect changes so no-
tification or reload is usually instant. On Linux, Wing polls the disk by default every 3
seconds; this frequency can be changed with the cache-reload-freq preference.

4.11 Normal Editor Personality

Wing’s source code editor can run with different personalities, either as a normal basic
text editor, or as an emacs-like editor that is readily controlled with keyboard-driven
commands.

The default personality for Wing is 'normal’. This uses only the graphical user interface
for interacting with the editor and doesn’t make use of any complex keyboard-driven
command interaction.

The editor runs in normal mode when the edit.personality preference is set to
normal . See section 2.1 of the Customization chapter for more information on how to
alter your preferences.

In normal mode, the editor provides the following keyboard equivalents, which are de-
fined in the default normal mode key mapping in file WINGHOME/keymap.normal .
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411.1 Cursor Movement

Key Combination Command Description
shift + arrow keys previous-line- Move cursor in indicated direction,
extend, extending the current text selection.

next-line-extend,
backward-char-

extend,

forward-char-

extend
shift-page-up and forward-page- Move forward or backward a page,
shift-page-down extend, extending the current text selection.

backward-page-
extend

ctrl-right-arrow and
ctrl-left-arrow

backward-word,
forward-word

Move cursor backward or forward a
word. These can be combined with shift
key for extension of selection.

home and end

beginning-of-line,
end-of-line

Move cursor to beginning or end of line.
Repeated home on an indented line will
alternate between the absolute
beginning and end of indentation. These
can be combined with shift key for
extension of selection.

ctrl-home and
ctrl-end

start-of-document,
end-of-document

Move cursor to beginning or end of
document. These can be combined with
the shift key for extension of selection.

4.11.2 Indentation

Key Combination

Command

Description

tab

indent-to-match

Indent the current line or selection to
match the preceding non-blank line,
adding or subtracting indentation as
appropriate. See section 4.6 above for
more information on indentation
behavior.

ctrl-tab

forward-tab

Insert a forward tab character.
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shift-tab backward-tab Insert a backward tab character.
ctrl-> indent-region Increase indent of the current line or
selected region by one level of
indentation.
ctrl-< outdent-region Decrease indent of the current line or

selected region by one level of
indentation.

4.11.3 Commenting and Justification

Key Combination Command Description
ctrl-/ comment-out- Comment out the selected region of
region code. This operates on whole lines,

extending the current selection as
necessary.

ctrl-? uncomment-out- Undo commenting out the selected
region region of code. This operates on whole
lines, extending the current selection as
necessary.
ctrlj till-paragraph Rejustify the paragraph of text at the

current selection’s starting position. This
operates on whole lines, and is most
useful for formatting comments, long
strings, or documentation. Set the
column at which to wrap with the
edit.text-wrap-column preference.

4.11.4 Insertion and Deletion

Key Combination

Command

Description

delete

forward-delete-char

Delete the character in front of the
cursor, or the current selection if not
empty.

ctrl-delete

forward-delete-
word

Delete the word in front of the cursor.
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insert

toggle-overtype

Alternate between overtype and insert
mode.

ctrl-backspace or
alt-backspace or
alt-delete

backward-delete-
word

Delete the word behind the cursor.

4.11.5 Undo and Clipboard

Key Combination | Command Description

ctrl-z undo Undo most recent edit.

ctrl-y redo Redo most recent undone edit.

ctrl-x cut Cut the current selection to clipboard.

ctrl-c copy Copy the current selection to clipboard.

ctrl-v paste Paste from clipboard, replacing the
current selection.

ctrl-a select-all Select the entire document.

4.11.6 File and Window Control

new-window

Key Combination Command Description

ctrl-n new-file Creates a new source view with an
untitled new file name.

ctrl-o open-gui Open a new document from disk.

ctrl-s save Save the current document to disk.

shift-alt-d delete-window Close the current view, and the window
if it’s the last view in the window.

shift-alt-w clone-window Create a new editor window containing
all the same source views as the current
window.

shift-alt-e move-editor-to- Move the current source editor view to a

new window, removing it from its
current window. This is only available in
multi-view mode and when there is
more than one view in the current
window.
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ctrl-w

kill-buffer

Close the current file, prompting to save
if necessary. Only closes the current
window when the last view in the
window is closed.

4.11.7 Search and Replace

Key Combination

Command

Description

ctrl-alt-f

search-manager

Display the search manager dialog.

ctrl-f search-forward Initiate search in current document.

ctrl-r query-replace Initiate search/replace in current
document.

ctrl-i replace-and-search | Replace given occurence and search
again.

ctrl-1 goto-line Jump to a selected line number.

4.11.8 Macros
Key Combination | Command Description

ctrl-(

start-kbd-macro

Start recording a macro (will contain any
keystrokes and commands issued to the
editor).

ctrl-) stop-kbd-macro Stop recording current macro and store
it.
ctrl-m execute-kbd-macro | Execute most recently defined keyboard

macro relative to current cursor position.

4.11.9 Other

Key Combination

Command

Description

ctrl-e or ctrl-]

brace-match

Select the region between the nearest
braces or defining the inner most code
block reached from current cursor
position.
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ctrl-right-click

goto-selected-
symbol-defn

Jump to point of definition of the symbol
clicked on.

ctrl + keypad plus
and minus keys

Zoom-in, zoom-out

Zoom text in and out by increasing and
decreasing font sizes.

ctrl-p

print-view

Print the current editor view.

See the section 2.2.3 for information on how to alter or replace this mapping.

4,12 Emacs Emulation

When preference edit.personality

is set to “emacs’, the editor will run in a mode

that emulates many emacs behaviors. In this mode, key strokes can be used to control
most of the editor’s functionality, using a textual interaction "'mini-buffer” at the bottom
of the editor window where the current line number and other informational messages

are normally displayed.

When in emacs mode, the editor supports the following key combinations for access to

commands.

4.12.1 Cursor Movement

next-line-extend,
backward-char-
extend,
forward-char-
extend

Key Combination | Command Description
shift + arrow keys previous-line- Move cursor in indicated direction,
extend, extending the current text selection.

ctrl + space bar

set-mark-command

Set selection start to current position and
start automatically selecting from that
point as the cursor is moved with arrow
keys, page up/down, search commands,
or in other ways.
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ctrl-g stop-mark- Cancel selecting a range, as initiated by
command set-mark-command, and set the cursor

position to the end of the range.

home and end or
ctrl-a and ctrl-e

beginning-of-line,
end-of-line

Move cursor to beginning or end of line.
Repeated home on an indented line will
alternate between the absolute
beginning and end of indentation. These
can be combined with shift key for
extension of selection.

ctrl-n and ctrl-p

next-line and
previous-line

Move cursor to next or previous line.

ctrl-b and ctrl-f

backward-char and
forward-char

Move cursor backward or forward one
character.

ctrl-v and alt-v

forward-page and
backward-page

Move forward or backward one page.

ctrl-home and

start-of-document,

Move cursor to beginning or end of

ctrl-end end-of-document document. These can be combined with
the shift key for extension of selection.
ctrl-1 center-cursor Center the cursor on screen.

4.12.2 Indentation

Key Combination

Command

Description

tab

indent-to-match

Indent the current line or selection to
match the preceding non-blank line,

adding or subtracting indentation as
appropriate. See section 4.6 for more
information on indentation behavior.

ctrl-c > indent-region Increase indentation of the currently
selected range of lines (or current line
when selection is empty) by one
indentation level.

ctrl-c < outdent-region Reduce indentation of the selected range
of lines (or current line when selection is
empty) by one indentation level.

ctrl-tab forward-tab Insert a forward tab character.

shift-tab backward-tab Insert a backward tab character.
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4.12.3 Commenting and Justification

Key Combination | Command Description
ctrl-c c or ctrl-c # comment-out- Comment out the selected region of
region code. This operates on whole lines,

extending the current selection as
necessary.

ctrl-cu

uncomment-out-
region

Undo commenting out the selected
region of code. This operates on whole
lines, extending the current selection as
necessary.

escape q or ctrl-j

fill-paragraph

Rejustify the paragraph of text at the
current selection’s starting position. This
operates on whole lines, and is most
useful for formatting comments, long
strings, or documentation. Set the
column at which to wrap with the

edit.text-wrap-column preference.

4.12.4 Insertion and Deletion

Key Combination

Command

Description

ctrl-d

forward-delete-char

Delete the character in front of the
cursor, or the current selection if not
empty.

ctrl-delete or alt-d

forward-delete-

Delete the word in front of the cursor.

word
delete clear Delete current selection, if any.
insert toggle-overtype Alternate between overtype and insert

mode.

ctrl-backspace or
alt-backspace or
alt-delete

backward-delete-
word

Delete the word behind the cursor.

4.12.5 Undo and Clipboard

| Key Combination

| Command

| Description
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ctrl-/ or ctrl-x u undo

Undo the most recent edit action.

ctrl-w or shift-delete | cut

Cut the current selection to system-wide
clipboard.

alt-w or ctrl-insert copy

Copy the current selection to
system-wide clipboard.

ctrl-y or shift-insert | paste

Paste from system-wide clipboard,
replacing any current selection.

ctrl-k kill-line

Remove the current line after the cursor
point and place it into the kill buffer.
Groups of lines deleted this way can be
pasted subsequently with yank-line
(ctrl-y). This is kept seperate from the
system-wide clipboard and (on X
windows) from the current selection.
This command removes the newline
only if there is no visible character on
the line after the cursor.

ctrl-y yank-line

Paste the current contents of the kill
buffer, created with one or more adjacent
kill-line commands, replacing any
current selection. If the kill buffer is
empty, the contents of the system-wide
clipboard is pasted instead.

4.12.6 File and Window Control

Key Combination | Command Description

ctrl-x ctrl-c quit Quit the application, first prompting to
save any unsaved documents.

ctrl-x ctrl-s save Save current file to disk.

ctrl-x k kill-buffer Close the current file, prompting to save
if necessary. Only closes the current
window when the last view in the
window is closed.

Version 1.1.4 Wing IDE Lite Reference




4.12. EMACS EMULATION

49

ctrl-x ctrl-f open

Open a file from disk. Enter the filename
at prompt, optionally using the tab key
to auto-complete the current entry. Two
tabs in a row will display a list of
possible matches; continue typing or
click on a match as desired. You can also
use the up/down arrow keys to scroll
through recently-opened files. Hitting
enter opens the selected file. Exit
without opening with ctrl-g or esc.

ctrl-x i insert-file

Insert a file at current cursor position.
Interaction is the same as for the open
command.

ctrl-x 52 clone-window

Create a new editor window containing
all the same source views as the current
window.

ctrl-x 5 3 move-editor-to-

new-window

Create a new editor window containing
the current source view, moving the
view out of its current window. This is
only available in multi view mode and
only when there is more than one view
in the current window.

ctrl-x b switch-document

Switch to another document. Hit enter
to select the specified default, type file
name fragments (tab and double-tab can
be used for completion and viewing list
of matches), or use the up/down arrow
keys to scroll through a list of options.
Enter accepts and switches; escape or
ctrl-g aborts.

ctrl-x 50 delete-window

Close the current editor window.

4.12.7 Search and Replace

| Key Combination | Command

| Description
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ctrl-s search-forward Initiate interactive incremental forward
search. The search is case sensitive if you
type any capital letters; otherwise
case-insensitive. Exit search by using
arrow keys or other commands, or abort
(returning to original position) with
ctrl-g or esc.

ctrl-r search-backward Initiate interactive incremental
backward search. Acts like forward
search, only proceeds backward in

source.
alt-percent or query-replace Initiate interactive query/replace. First
escape percent type search string, then replace string

and respond to prompts with 'y” and 'n’.
You may use the tab key to
auto-complete values you type into the
search and replace strings. End the
session with ctrl-g or escape.

alt-g or alt-1 or goto-line Go to a specific line; enter the line
escape g number at prompt.

4.12.8 Macros

Key Combination Command Description

ctrl-x ( start-kbd-macro Start recording a macro (will contain any
keystrokes and commands issued to the
editor).

ctrl-x ) stop-kbd-macro Stop recording current macro and store
it.

ctrl-x m execute-kbd-macro | Execute most recently defined keyboard
macro relative to current cursor position.

escape + numbers initiate-repeat-* Start entering a repeat value which will

cause the immediately following
command or keystroke to be executed
the specified number of times. Use esc or
ctrl-g to abort. This is particularly useful
to execute a keyboard macro multiple
times in a row.
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4129 Other

Key Combination

Command

Description

ctrl-m

brace-match

Select the region between the nearest
braces or defining the inner most code
block reached from current cursor
position.

ctrl-right-click

goto-selected-
symbol-defn

Jump to point of definition of the symbol
clicked on.

ctrl + keypad plus
and minus keys

zoom-in, zoom-out

Zoom text in and out by increasing and
decreasing font sizes.

alt-x or escape x

command-by-name

Enter a command by name for execution.
Use the tab key for auto-completion or
double-tab to see a list of possible
matches. Up/down arrow keys also
work for scrolling through recent
commands. Hit enter to execute the
command or esc or ctrl-g to abort.

Many of these commands are also available through menu items. See section 2.2.3 for
information on how to alter or replace this mapping.

4.13 Search/Replace

All editor modes include a graphical search/replace manager, which can be brought up
with the Search Manager item in the Edit menu. Commands in this window will apply to
the current (most recently at front) source view.

To use this manager, enter search and optionally replace text, set search options, and
control the search/replace process with the provided buttons.

Replace actions can always be undone, including Replace All

Emacs mode additionally provides ctrl-s and ctrl-r incremental search, and query-replace
facilities, as described in section 4.12.7 above.
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4.14 Keyboard Macros

The Edit menu contains items for starting and completing definition of a keyboard or
command sequence macro, and for executing the most recently defined macro. Once
macro recording is started, any keystroke or editor command is recorded as part of that
macro. Most commands listed in sections 4.11 and 4.12 above may be included in macros,
as well as all character insertions and deletions.

The keyboard macro feature is currently most useful in emacs mode, where powerful
cursor-relative macros can be built for repetitive reformatting tasks. This is done by com-
bining incremental search with cursor movement and typing.

4.14.1 Example (in Emacs mode)

A common task when writing Python bindings for C/C++ libraries is copying lists of
#define constants and converting them into Python variable assignments.

#define SC_MARK_CIRCLE 0
#define SC_MARK_ROUNDRECT 1
#define SC_MARK_ARROW 2
#define SC_MARK_SMALLRECT 3
#define SC_MARK_SHORTARROW 4
#define SC_MARK_EMPTY 5
#define SC_MARK_ARROWDOWN 6
#define SC_MARK_MINUS 7

#define SC_MARK_PLUS 8

In emacs mode, the above can be converted by positioning the cursor before the first
#define , starting macro definition, and executing the following keystrokes:

escape 8 ctrl-d ctrl-s <space> <right arrow> = <space> ctrl-
a <down arrow>

This deletes the 8 characters ‘#define  ’ (with trailing space) in front of the cursor, jumps
to the space after the constant identifier, inserts ‘= ’, and moves to the beginning of the
next line. When this is complete, stop macro recording and type the following to convert
the remaining lines:
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escape 8 ctrl-x e

This will execute the macro eight times resulting in the following reformatted source (the
tirst line was reformatted during the creation of the macro):

SC_MARK_CIRCLE = 0
SC_MARK_ROUNDRECT = 1
SC_MARK_ARROW = 2
SC_MARK_SMALLRECT = 3
SC_MARK_SHORTARROW = 4
SC_MARK_EMPTY = 5
SC_MARK_ARROWDOWN = 6
SC_MARK_MINUS = 7
SC_MARK_PLUS = 8

Combine this technique with ctrl-space (set-mark-command) and copy/paste to alter the
order of constructs within a line. Be creative... and don’t forget that undo can be used to
tix problems caused by incorrect macros or bad cursor position before executing a macro.

Macros will terminate if any command within the macro fails (for example, if an incre-
mental search fails). This can be used to prevent edits when a macro is executed in a
location where it doesn’t make sense.

4.14.2 Repetition

In emacs mode, macros can be executed over and over again by using the escape +
numbers key board interaction to set up a repetition count before executing the macro.
For example, type ‘escape 1 0 ctrl-x e’ in emacs mode to execute a macro ten times in a
row.

4.15 Source Code Analysis

Wing’s auto-completer, source index menu, goto-definition capability, and some of the
source reformatting features all rely on a central engine that reads and analyzes your
source code in the background as you add files to your project or alter your code in the
source code editor.
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4.15.1 Python versions

* In analysing your source, Wing will use the Python interpreter and PYTHONPATHhat
you have specified in your debug properties. If you have indicated a main debug file
for your project, the values from that file’s per-file debug properties are used; otherwise
the project-wide values are used. Whenever any of these values changes, Wing will com-
pletely re-analyze your source code from scratch.

You can view the Python interpreter and PYTHONPATIthat are being used by the source
code analysis engine, by selecting the Show Analysis Stats item in the Source menu. The
values shown in the resulting dialog window are read-only but may be changed by push-
ing the Settings button. See section 5.2 for details on changing these values.

Be aware that if you use multiple versions of the Python interpreter or different
PYTHONPATHalues for different source files in your project, Wing will analyse all files
in the project using the one interpreter version and PYTHONPATHk finds through the
main debug file or project-wide debug properties settings. This may lead to incorrect or
incomplete analysis of some source, so it is best to use only one version of Python with
each Wing IDE project file.

4.15.2 Limitations

The following are known limitations affecting features based on source analysis:

® Analysis sometimes fails to identify the type of a construct because Python code
doesn’t always provide clues to determine the data type. In these cases, you may
use assertion of isinstance  to inform the analyzer, as described below.

® Types of elements in lists, tuples, and dictionaries are not identified.

® Docstrings and other analysis information may be out of date if you edit a file exter-
nally with another editor and don’t reload it in Wing. See section 4.10 for a discussion
of the reload options.

® Some newer Python language constructs and possible type inferencing cases are not
explicitely supported.
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* One way to inform the code analysis facility of the type of a variable is to add an
isinstance  call in your code. An example is assert isinstance(obj, CMyClass)
The code analyzer will pick up on these and present more complete information for the
asserted values. This assertion may have the side-effect of catching type errors at the
time isinstance  is called rather then when an invalid operation is attempted.

4.15.3 Disk Cache

The source code analyzer writes information about files it has recently examined under

“l.wingide/cache (on Linux) or WINGHOME\profiles\[username]\cache (on
Windows).
Cache size may be controlled with the pysource.max-disk-cache-size preference.

However, Wing does not perform well if the space available for the cache is smaller than
the space needed for a single project’s source analysis information. If you see excessive
slowdowns, either increase the size of the cache or disable it entirely by setting its size to

0.

If the cache will be used by more than one computer, make sure the clocks of the two
computers are synchronized. The caching mechanism uses time stamps, and may become
confused if this is not done.

The analysis cache may be removed in its entirety with no ill ef-
fects (for example ’‘rm -rf “/.wingide/cache " on Linux or remove
WINGHOME\profiles\[username]\cache on Windows). It will be rebuilt as needed
subsequently unless it has been disabled.
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416 Preferences
The following preferences are defined for the editor:

0 edit.new-file-extension - This defines the text, if any, to append to all newly created
untitled documents. Default=".py’

O edit.new-file-eol-style - This defines the end-of-line style that is used for a newly cre-
ated file (otherwise, the style used matches existing file content). Select one value for
each platform: One of If’, cr’, or “crlf’ for each entry. Default{’linux’ If,

'win32": ‘crif’}

O edit.personality - Selects the editor personality. Default="normal’

0 edit.tab-size - Sets the tab size, in spaces. This is forced to 8 for all Python files, since
the Python interpreter assumes tab size of 8. Default=8

O edit.indent-size - Sets size of each indentation level, in spaces. Default=2

0 edit.indent-style - Determines the style of indentation to use by default in new Python
source files, and in all non-Python files. This can be one of 'spaces-only’ for spaces
only in indentation, 'tabs-only’ to use tabs only, or 'mixed’  to use a mix of tabs
and spaces (not recommended). Default="spaces-only’

O edit.use-tabs-to-indent-default - This is a deprecated preference and is no longer
used. Use edit.indent-style instead.

O edit.auto-indent - Set to true to automatically indent each new line. Default=true

O edit.show-whitespace - Set to true to show tabs and spaces with visible characters
by default. This value may then be overridden on a file by file basis from the Source
menu. Default=false

O edit.show-indent-guides - Set to true  to show light vertical lines at each indent level.
This value may then be overridden on a file by file basis from indentation section of
the Source menu. Default=false

O edit.show-eol - Set to true to show end of line characters with visible characters by
default. This value may then be overridden on a file by file basis from the Source
menu. Default=false
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O

edit.display-font - A map that defines the font to use for source code dis-
play on each supported platform. Default={ ’linux’: ’lucidatypewriter’,
'win32’: 'Courier New’ }

edit.display-size - A map that defines the font size to use for source code display on
each supported platform. Default={ ’'linux: 12, 'win32" 11 }

edit.print-font - (Linux only) Sets the font name wused in printing
Python files. One of ’'Courier , 'Helvetica’ , or 'Times-Roman’
Default={ ’linux’: 'Courier’, 'win32’: 'unused’ }

edit.print-size - (Linux only) Sets the font size used to print Python files.
Default={ ’linux: 12, 'win32’: 'unused’ }

edit.print-paper - (Linux only) Sets the paper size used for printing.
One of ’Letter’ , ’Legal , 'A3 , 'A4 , 'A5 , 'BS , 'C6 , etc
Default={ ’linux’: 'Letter’, 'win32": 'unused’ }

edit.print-python-as-text - (Linux only) Set this to true  to print Python files faster but
without syntax highlighting. Otherwise the internal Python pretty printing facility is
used. Default={ ’linux’: false, 'win32’: 'unused’ }

edit.text-print-cmd - (Linux only) Sets the default command that is issued to print
non-Python text files. The command is text with embedded %s to indicate where
the printed file’s name should be inserted. Default={ ’linux’: ’enscript --
pretty-print \%s’, 'win32’: 'unused’ }

edit.print-header-format - (Windows only) Set the header format to use for printing.
This can be " any text with any of the following special fields mixed in: %basename%
- base file name; %prepend-fullpath% - full path file name; %prepend-relative% - rel-
ative path with from project file; %append-relative% - file name with relative path
appended; %append-fullpath% - file name with full path appended; %file-time% -
file modification time; %file-date% - file modification date; %current-time% - cur-
rent time; %current-date% - current date; %page% - current page being printed.
Default={linux’: 'unused’, 'win32’: "%prepend-fullpath\%’ }

edit.print-footer-format - (Windows only) Set the footer format to use for print-
ing. Same allowable values as for edit.print-header-format preference.
Default={linux: 'unused’, 'win32’: 'Page \%page\%, last modi-

fied \%file-date\% \%file-time\%’}

edit.print-header-style - (Windows only) Text style to wuse in print
header, defined as comma delimited list of name:value pairs or style
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names including;: font:fontname, size:ptsize, bold, italics, underlined.
Default={linux’: 'unused’, 'win32’: 'font:Arial,size:12,bold’}

edit.print-footer-style - (Windows only) Text style to use in print footer.
Same allowable values as for edit.print-header-style preference.
Default={linux’: 'unused’, 'win32’: 'font:Arial,size:10,italics’}

edit.suspend-analysis-timeout - The number of seconds between last key press and
when the background code analysis is reenabled. Altering this value may make typing
more or less responsive. When less than or equal to zero, analysis is never suspended
during typing. Default=3

edit.typing-timeout-interval - Timeout in seconds between last key press and when
user is considered not be be typing, for purposes of hiding auto-completion and call
tips popups. Default=0

edit.autocomplete-names - Controls whether or not to display the auto-completion
popup while editing Python source. Default=true

edit.autocomplete-attribs - Controls whether or not to autocomplete attributes (items
after ’.” in identifiers) while editing Python source. Default=true

edit.autocomplete-keywords - Controls whether or not to autocomplete Python key-
words while editing Python source. If None, the list is obtained from the keywords
module in the Wing source code. Default=None

edit.autocomplete-builtin-names - Sequence of built-in names to be used in Python
autocompletion lists. If None, the list is obtained from the __builtins__ module in
the Wing source code. Default=None

edit.autocomplete-names-to-always-del - Sequence of names to always delete from
initial autocompletion lists. If set to None, the list defaults to an internal value.
Default=None

edit.autocomplete-names-to-del-if-line-start - Sequence of names to always delete
from initial autocompletion lists if the name is the first one on the line. If None, de-
faults to an internal value. Default=None

edit.autocomplete-names-to-del-if-not-line-start - Sequence of names to always
delete from initial autocompletion lists if the name is not the first one on the line.
If None, defaults to an internal value. Default=None
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O

edit.autocomplete-standard-exception-names - Sequence of names of standard (built-
in) exceptions to include in autocompletion lists. If None, defaults to an internal value.
Default=None

edit.autocomplete-word-middle-action - Whether or not to auto-complete when typ-
ing in the middle of a word. Default=true

edit.text-wrap-column - The column at which text is wrapped by the fill-paragraph
command. Default=70

edit.lineno-column-width - The width of the line number display column, or O to
hide it entirely. This is the default value; any changes from the GUI are recorded in
the project file. Default=0

edit.enable-folding - Set to true to enable structural folding in source editors by
default, or false to disable. This is the default value; any changes made from the
GUI are recorded in the project file and subsequently override this preference setting.
Default=true

edit.fold-mime-types - Set to a list of mime types for which folding should
be enabled by default when preference enable-folding has been turned on
to enable folding as a whole. Default=[ 'text/x-python’, 'text/x-c-

source’, 'text/x-cpp-source’, ’text/x-java-source’, ’text/x-

javascript’, ‘text/html’, ‘text/x-eiffel’, 'text/x-lisp’,

text/x-ruby ]

edit.fold-line-mode - Set to “expanded-above”, ”expanded-below”, ”collapsed-
above”, ”collapsed-below”, or “none” to indicate where fold lines are shown
and whether they are above or below the line where the fold point is located.
Default="above-collapsed"

edit.fold-indicator-style - Set to an integer to determine the style of fold indicators
used with structural folding: O for arrow indicators, 1 for plus/minus indicators, 2
for rounded tree indicators, and 3 for square tree indicators.

edit.select-policy - This is a map from actions to policy for leaving a range selected
after the action takes place. Possible actions are “indent-region”, “outdent-region”,
“indent-to-match”, ”“comment-out-region”, and “uncomment-out-region”. Possible
policies for each are “always-select”, which always leaves a selection, “retain-select”
which leaves a selection only if there was one to begin with, and "never-select” which

never leaves a selection. Default={ ’indent-region’: ’retain-select’,
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‘'outdent-region’: ’retain-select’, ’indent-to-match’: ’retain-
select’, 'comment-out-region’: 'never-select’, 'uncomment-out-
region’: 'never-select’ }

The following additional preferences that control reloading of file caches are also relevant:

U

cache.unchanged-reload-policy - Selects action to perform on files found to be exter-
nally changed but unaltered within the IDE. One of "auto-reload" to automat-
ically reload these files, "request-reload"” to ask via a dialog box upon detec-
tion, "edit-reload" to ask only if the unchanged file is edited within the IDE sub-
sequently, or "never-reload" to ignore external changes (although you will still
be warned if you try to save over an externally changed file). Default="request-
reload"

cache.changed-reload-policy - Selects action to perform on files found to be externally
changed and that also have been altered in the IDE. One of "request-reload" to
ask via a dialog box upon detection, "edit-reload" to ask if the file is edited further,
or "never-reload" to ignore external changes (although you will always be warned
if you try to save over an externally changed file). Default="request-reload"

cache.reload-check-freq - Time in seconds indicating the frequency with which the
IDE should check the disk for currently open files that have changed externally. Set to
0 to disable entirely. Default=3.0

You need to quit and restart Wing before any changes in these preferences take effect.
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Chapter 5

Debugger

This chapter describes how to use the Wing IDE debugger.

The Wing debugger consists of two parts: (1) the debug client, represented by the debug-
ger window in Wing IDE, and (2) the debug server, which resides within another process
space, possibly on another machine, and communicates with the client via TCP/IP.

The debugger supports launching your application not just from Wing itself but also ex-
ternally, as with CGI scripts or code running in an embedded scripting facility within a
larger application.

When externally launched, your code can attach to the Wing IDE debugger at any point
in its execution, and may turn on and off debugging using a simple APL

Because the debugger core is written in optimized C, debug overhead is relatively
low; however, you should expect your programs to run about 50% slower within the
debugger.

5.1 Specifying Main Entry Point

Normally, Wing will start debugging in whatever file you have as your front- most win-
dow. Depending on the nature of your project, you may wish to specify a file as the
default debug entry point.
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To do this, right-click on one of your Python files in the Project Manager window and
choose the Set As Main Debug File option from the popup menu. This file is subsequently
executed whenever you start the debugger, except if you use the Debug Selection in the
Project Manager’s popup menu.

Note that the project manager will highlight the main entry point in red. You may clear
the default main debug file subsequently by using the Clear Main Debug File item in the
Project Manager window’s popup menu.

Regardless of whether a main debug file is defined, you can also start debugging any
open file with Debug Current File in the Debug menu, or by right-clicking on an entry in
the project manager and choosing the Debug Selection popup menu item.

The main entry point defined for a project is also used by the source code analysis engine
to determine the python interpreter version and python path to use for analysis. Thus,
changing this value will cause all source files in your project to be reanalysed from scratch.
See section 4.15 for details.

5.2 Debug Properties

In some cases, you will also need to set up some properties to use when debugging.
These are set either on a project-wide basis or may be specified on a per-file basis using
the main entry point file for the debug session. Project-wide debug properties apply in
all cases where a per-file value was not given; otherwise the per-file value overrides the
project-wide values.

Only per-file debug properties set on the initially invoked file are used in the debug session.
Even if other files with set properties are used in the debug session, any values set for
them will be ignored.

Debug properties may be set project-wide from the Properties item in the Project menu.
Per-file debug properties may be set from the Current File Debug Properties item in the
Run menu, or from the Set Debug Properties item in the right-click popup menu on the
project manager.
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5.2.1 Project-wide Properties

The project-wide properties dialog contains the following fields:

e Python Executable - When the Custom setting radio button is checked and the entered
tield is non-blank, this can be used to set the full path to the Python installation that
should be used when debugging source code in this project. This can be used to control
whether the debug program is executed under Python 1.5.2, 2.0, 2.1, or 2.2. When Use
"python” is selected, Wing tries to use the default Python obtained by typing python
on the command line. If this fails, Wing will search for Python in /usr/local and
fusr (on Linux) or in the registry (on Windows).

e Python Path - The PYTHONPATIES used by Python to locate modules that are imported
at runtime with the import statement. When the Use environment checkbox in this
area is checked, the inherited PYTHONPATHnvironment variable is used for debug
sessions. Otherwise, is Custom setting is selected, the specified PYTHONPATIt used.

® Run Directory - When the Use file’s directory radio button is checked, the initial working
directory set for each debug session will be the location where the main entry point file
is located. Otherwise, when Custom setting is selected, the specified directory is used
or, when blank, the project file’s directory is used.

® Build Command - This command will be executed before starting debug on any source
in this project. This is useful to make sure that C/C++ extension modules are built, for
example in conjunction with an external Makefile , before execution is started.

e Environment - This is used to specify values that should be added, modified, or re-
moved from the environment that is inherited by debug processes started from Wing
IDE. Each entry is in var=value = form and must be specified one per line in the pro-
vided entry area. An entry in the form var= (without a value) will cause the given
variable to be undefined. Note that you are operating on the environment inherited
from the IDE and not defining a blank new environment space. When the Use env ra-
dio button is checked, any entered values are ignored and the inherited environment
is used without changes.

® Debug Console - This is used to control whether or not Wing creates a new console
when it launches your debug process. By default, this value is set to the debug.use-
console preference. As shipped, Wing does not show a new console and reuses the
console from which Wing was launched (if any) for any command line I/O performed
by the debug program. If you are launching Wing from the Start menu on Windows
or similar mechanism on Linux, and your debug program uses the command line, set
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this value to Start New Console. Otherwise, you will not see your program’s output.
When Start New Console is selected, you can optionally cause the console to remain
until you press a key in it by setting the preference debug.persist-console to
true , or set a breakpoint at the very end of your program. When Wing is running in
an environment where it cannot allow the debug process to inherit Wing’s console (or
there is no console), the Use Inherited Console option is replaced with Use No Console.

All of these values are stored in the project file on a per-platform basis. This means that
when a project is used both on Linux and on Windows (via file sharing or source code
control), you must set values seperately for each platform. Wing shows and edits only
the values for the platform you are currently running on.

If you are sharing a project file with other developers through a revision control system,
and have set Project Type from the Project menu to Shared, it is important to note that
the above values are stored in the private branch of the project file. This means that each
developer needs to set these values independently, to match the specific environment on
their development machine.

5.2.2 Per-file Properties

The per-file debug properties dialog contains all the same fields as are available in the
project-wide properties described above, with the following additions:

® Run Arguments - Enter any run arguments here, including the name of the Python
source file as the first item in the list.

e Environment - This entry area contains some additional radio button options in the
per-file properties area. Use ‘add to project’ to cause the values specified here to be
applied to the inherited runtime environment after the project-wide values are applied,
or ‘add to env’ to bypass the project-wide values and apply the per-file values directly
to the inherited runtime environment.

® Show this dialog before each run - Check this checkbox if you want the debug options
dialog to appear each time you start a debug session.

Custom values entered here will override any project-wide values.
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5.2.3 Relation to Source Analysis

The per-file and project-wide debug properties are also used by the source code analysis
engine in order to determine the Python interpreter version and PYTHONPATHb use in
analysis. For this reason, changing either Python Executable or Python Path in the debug
properties dialogs will cause Wing to reanalyse your entire source base from scratch. See
section 4.15 for details.

5.3 Setting Breakpoints

Breakpoints can be set on source code by opening the source file and clicking on the
breakpoint margin to the left of a line of source code. Alternatively, the Breakpoints menu
or the toolbar’s breakpoint icons can be used to set or clear breakpoints at the current line
of source (where the insertion cursor or selection is located).

5.4 Starting a Debug Session

There are several ways in which to start a debug session from within Wing:

® Choose Debug from the Run menu or push the Start debug tool bar icon. This will
run the project’s main debug file (described in section 5.1), if one has been defined, or
otherwise the file that is open in the frontmost editor window. Execution will stop on
the first line of the code.

® Choose Debug Current File from the Run menu or Debug Selection from the right-click
popup menu on the project manager to run a specific file regardless of whether a main
debug file has been specified for your project. This will stop on the first line of the
code.

® Choose Continue from the Run menu or push the Run To Breakpoint icon in the tool-
bar. This will run the main debug file if one has been defined, or otherwise the file open
in the frontmost editor window. Execution continues until a breakpoint or exception
is encountered.

® Choose Run to Cursor from the Run menu or push the Run To Cursor icon in the
toolbar. This will run the main debug file if one has been defined or otherwise the
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file open in the frontmost editor window. Execution continues until it reaches the
line selected in the current source text window, or until a breakpoint or exception is
encountered.

Note that additional options exist for initiating a debug session from outside of Wing and
for attaching to an already-running process. These are described in section 5.11 below.

5.5 Flow Control

Once the debugger is running, the following commands are available for controlling fur-
ther execution of the debug program from Wing. These are accessible from the middle
panel of the tool bar or from the Run menu:

e At any time, a freely running debug program can be paused with the Pause item in
the Run menu or with the pause tool bar button. This will stop at the current point of
execution of the debug program.

e Continue and Run To Cursor are also available during the debug session, whenever
the program is in paused (non-running) state. These act the same way they do if used
to initiate the debug session in the first place.

® At any time during a debug session, the Kill menu item or tool can be used to force
termination of the debug program. Note that this stops running the debug program
without executing any further lines of code, so may result in problems with code that
assumes it will get a chance to do cleanup tasks upon exit. This option is disabled if the
current process was launched outside of Wing, so that only those processes spawned
by Wing can be terminated in this way:.

When stopped on a given line of code, execution can be stepped line-by-line by using the
Step Over, Step Into, and Step Out menu item or tool bar icons:

® Step Over will step over a single Python instruction, whether or not doing so will
proceed to a new line of code.

e Step Into will attempt to step into the next executed function on the current line of
code. If there is no function or method to step into, this command acts like Step Over.

® Step Out will complete execution of the current function or method and stop on the
tirst instruction encountered after returning from the current function or method.
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5.6 Viewing the Stack

Whenever the debug program is paused at a breakpoint or during manual stepping, the
current stack is displayed as a list in the top panel of the debugger window. This list
shows all stack frames encountered between invocation of the program and the current
run position. Outermost stack frames are higher up on the list.

Note that the stack displayed is a concatenation of all Python stack frames seen, and may
include discontinuities if your code calls C/C++ or other non-Python code, which in turn
makes calls back into Python. In this case, the C/C++ stack frames will be missing but
the overall order and flow of invocation should be apparent from those stack frames that
are visible.

When the debugger steps or stops at a breakpoint or exception, it selects the innermost
stack frame by default.

In order to visit other stack frames further up or down the stack, use the Up Stack and
Down Stack items in the Run menu or the up/down tool bar icons. You can also click
directly on the surface of the stack in the top panel of the debugger window.

When you change stack frames, the variables views will be changed accordingly, and the
current line of code at that stack frame is presented in an editor window.

5.7 Viewing Variables

The Wing IDE debugger provides two ways in which to look at variables: (1) in a hier-
archical tree view that can be expanded and collapsed, and (2) in a textual view that can
be set to show a desired number of hierarchical levels. These two views are in the sec-
ond and third debugger window panels, respectively. Note that the relative sizes of these
panels can be adjusted by dragging the resize indicators on the dividers between them.

The variables data displayed by Wing is fetched from the debug server on the fly as
you navigate. Because of this, you may experience a brief delay when a change in an
expansion or stack frame results in a large data transfer.
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5.7.1 Tree View

The tree view contains two top-level entries: (1) locals, which contains all the locals
and parameters defined in the currently selected stack frame, and (2) globals, which are
scoped to be accessible from all stack frames. Note that in the top-level scope, these two
name spaces will be the same and will show the same data.

Simple values, such as strings and numbers, will be displayed in the value column of the
tree view area. Strings are always contained in " (double quotes). Any value outside of
quotes is a number or internally defined constant such as None or Ellipsis . Integers
can be displayed as decimal, hexadecimal, or octal. Default display mode is changed
with preference debug.default-integer-mode and may be altered from the Integer
Display area of the Run menu. Once set, the value is remembered in your project file.

Complex values, such as instances, lists, and dictionaries, will be presented with an angle-
bracketed type and memory address (for example, <dict 0x80ce388> ) and can be ex-
panded by clicking on the expansion indicator in the Variable column. The memory ad-
dress uniquely identifies the construct. Thus, if you see the same address in two places,
you are looking at two object references to the same instance.

Upon expansion of complex views, the position or name of each sub-entry will be dis-
played in the Variable column, and the value of each entry (possibly also complex values)
will be displayed in the Value column. Nested complex values can be expanded indefi-
nitely, even if this results in the traversal of cycles of object references.

Once you expand an entry, the debugger will continue to present that entry expanded,
even after you step further or restart the debug session. Expansion state is saved for the
duration of your Wing IDE session.
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Values that have not yet been defined in the flow of control are shown with value
<undefined>

Some data types, such as those defined only within C/C++ code, or those containing
certain Python language internals, cannot be transferred over the network. These are
denoted with Value entries in the form <opaque 0x80ce784> and cannot be expanded
further.

Values Class-scoped values seen within an instance are shown in italics.

When the debugger encounters a very long string, this is indicated in the Value column
by prepending <truncated> to the start of the value. In these cases, the full string can
be viewed by clicking on the value and using the Textual View panel at the bottom of the
debugger window (explained in section 5.7.2).

Other indicators such as <huge>, <error handling value> , and <network time-
out during evaluate> are also used. These are described in section 5.7.5.
Popup Menu Options

By right-clicking on the surface of the tree view of variables, it is possible to obtain a
popup menu that contains several commands useful in navigating data structures. Most
of the items in this popup menu act upon the specific data value that was right-clicked
upon:

® Zoom To Window - This will open the selected data value in a seperate variable view
window, using the default configured display and value tracking styles.

e Expand More - When a complex data value is clicked upon, and that value has parts
that are not yet expanded, this menu item will be enabled. It will expand one ad-
ditional level in the complex value. Note that since this expands a potentially large
number of values, you may experience a delay before the operation completes.

e Collapse More - When a complex data value is clicked upon, and that value has any
expanded parts, the value is collapsed by one additional level.

® Zoom and Track by Symbolic Path - This will open the selected data value in a seper-
ate variable view window, tracking its value by the symbolic path that was selected.

Wing IDE Lite Reference Version 1.1.4



70 Debugger

e Zoom and T